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DEALING WITH IMAGE COMPLICATIONS 

Thus far, we’ve been looking at software and techniques to create patterns and shapes like 
mandalas for coloring pages in and of themselves. That’s fine, but there is so much more we 
can do.  

Unfortunately, this can sometimes require some extra work. Images you get, whether public 
domain, photographs you take, stock images, etc. don’t just come the way you need them to 
be. The perfect image may be really perfect only after you can remove some of the 
background. The perfect image may come in color, lots of color and you need to convert it to 
blacks and whites. All of these things can create problems that have to be addressed before 
we can start making our coloring book images work. Let’s take a look at some of those 
situations. 
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Demonstration: Removing background Elements 

Image below is a stock image and it is a great image. I want to use it but I don’t want to use all 
of the stuff that is in the background. When I opened it in Illustrator and looked at the points/
paths, I don’t know how they created it but it is in sections of three (middle), a repeating 
pattern. Further, when you click on a white area and delete it, you discover that this entire thing 

is done with white parts drawn over a black background. You cannot just use the direct 
selection tool to delete white areas because you are left with black that is behind (above right). 
That makes it challenging to edit. There are some ways around this: 

METHOD 1 

The eraser tool is a great option. Left click and drag 
the cursor around and it erases the images (right) 
and forces the paths to re-draw. It isn’t perfect, but it 
works, and on some images, it is a good tool to use. 
The only problem is… doing this on an entire image 
like this is insane! It is tedious to the nth degree and 
would take forever.  

METHOD 2 

Another option is the knife tool. Start at a line right 
where you want to remove it (at the intersection) 
and carve a line (below left). This line doesn’t have 
to connect to anything including itself—you start in 
an open area and end in an open area—and when 
you release it, it isolates the black line (below right) 
and you can delete it.  

When you are finished with your edits, you will have some tiny extra points where you just 
can’t erase or cut out precisely enough. One way to manage this bunch of extra points is 
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Object > Path > Simplify. You want curve precision to be 
pretty close to 100%. Angle Threshold you can play with 
a little depending on the complexity of the image. It 
basically averages out the points and removes the 
extras. Turn on preview and adjust the angle threshold 
to see how it smooths out the lines and gets rid of extra 
points.  

So, method 2 might be faster than method 1, but it is still 
a long process for a complex image. I need a better way. 

METHOD 3 

1. Create new image 10” x 10”, 300 ppi, rgb in Photoshop > paste 
the original .eps into this. All the white is transparent in this 
image and we have only the black lines. Select > Color Range > 
eyedropper black, Fuzziness 200 so black is selected and 
everything else is currently transparent. 

2. Create a new layer > lock layer > command/control shift I to 
invert the selection (i.e. select everything that is not black) > fill 
to any color to help you see the image where black lines are now 
transparent (I chose a red here) > turn off original layer. 

3. Because where the lines were it is now transparent, it is easy to 
zoom in and use a tool like polygonal lasso to click points along 
the transparent “line” (it doesn’t have to be exact as long as you 
are within the transparent area when you draw) and select the 
area you want to isolate. It is easy to click around the transparent 
parts because there is nothing there. Once you’ve completed 

Page !  of !3 23



Advanced Coloring Book Design Tony Laidig

lassoing your selection, unlock layer > delete. Now you have the image below. 

4. That is great except there are no lines. Lock layer again > Edit > Fill > White > right mouse 

click > blending options > stroke, position 
outside, and increase the size of the stroke to 
fill in the size of the transparent space (right). 

You could position stroke on the inside for a 
totally different look (below). If you do this, you 
probably want to flatten image so the whole 
background is white as well. 

My goal, however, was to just use this section 
on the bottom with the transparent top so I 
could continue to build my coloring page on top 
of it. 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Demonstration: Dealing with Color Images 

Say you find an image like this and think it would 
make the perfect coloring page except it is already 
colored. Illustrator makes it somewhat easy to deal 
with this—as long as you make sure you are 
working with a vector image. We are going to look at 
multiple options because depending on the type of 
image you are working with, you may need to use 
one option vs. another. 

METHOD 1 

1. First, select the blue background and delete; select the text in lower left and delete. 

2. Select All > in the tools palette, change the fill to the default fill of white and 
stroke black just by clicking the little default button (circled) in the tools. When you 
click off the bird, you now have black lines and white fill (below) 
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3. The problem is if you zoom in you will see that they didn’t use a single stroke for the lines 
but a double stroke. So, the way the lines were made, we don’t get a clean, solid line. So, 
this isn’t the best result for this particular image. This isn’t the case for all vectors, but you 
may run into this and you need to know other options to solve this particular problem. 
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METHOD 2 

1. Alternatively, we can go back to the color image and remove colors one click at a time. Say 
I choose the orange circled in this image (below). Click on this one color block > Select > 
Same > Fill Color. Illustrator selects every instance of this color > go to fill color, change to 
white (image bottom). 

2. Repeat process for each color in the image. When we get through the colors, you have a 
black outline we want to maintain. 
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3. But we have a problem. One of 
their fill colors is black. We want 
to get rid of the fill that is black but 
retain the lines that are black. If 
we just repeat the process above, 
it will delete all the black. So, 
zoom in and select with the direct 
selection tool each of the fill areas 
where there is black fill. Once you 
get several of them selected > fill 
color white and it works fine. 
Repeat this until all the black fill 
has been changed to white. 
NOTE: you can do color 
replacement in Photoshop, but 
with a vector image, it is better to 
do it in Illustrator because you 
don’t lose any sharpness at all. 

4. Let’s say we don’t like some of 
the details in this image and want 
to change them. You can do that 
since we are working with 
vectors. Every little white blob, for 
example, is a separate item. We 
can click on any one and delete. 
We can also drag control points 
in any of the individual paths to edit them as you want. 
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MAKING MORE INTERESTING DESIGNS 

I like to mix images rather than just using a single image 
created with one of the apps or techniques we’ve 
demonstrated previously. So, let’s start with the image of the 
leaves I created for the bottom of a page and build on it. 

Demonstration: Compositing in Photoshop 

1. Change size of image to match the final coloring page size. 
Since I will make my coloring page 8.5” x 11” I need to 
make my image 8.75” wide (includes bleed). Change 
canvas size to match what my final coloring page size will 
be: 8.75” x 11.25” with bleed, adding the additional canvas 
to the top. Create new layer on bottom and fill to white. 

2. I have another illustration of Alice and flamingo. I edited it in Illustrator using the same 
techniques as above to remove some of the stuff around the image. Open in Photoshop 
and notice she is transparent. We need a fill of white. You are going to notice, especially in 
older images that there are gaps and for whatever reason, people who color hate gaps. 
That also makes it more difficult to fill the white background. So, I choose a paintbrush with 
100% hardness (smaller brush is better) and black color and just paint in to close the gaps 
around the outside of the image. 

3. Now that I took time to fill the gaps, I can click in the 
space outside her and it doesn’t bleed over and 
select anything inside her > command/ctrl shift I to 
invert selection (i.e. choose everything that is not the 
outside transparent area) > new layer > Edit > fill to 
white > merge layers. Around her is still transparent, 
but where she is now is white. 
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4. Left mouse click on her and drag her to the 
working document. Now we have Alice and 
flamingo in the scene. We may have to reduce 
her down, but we can do it as we go. It is a 
good idea here to add a stroke to her just so 
all the strokes in the page are of similar 
quality. Use the blending options > stroke on 
Alice the same way we’ve done numerous 
times before. If you see any spots you missed, 
just use the eraser tool to eliminate them. 

5. I found another object in my search on 
Shutterstock, a “Zentangle” style flamingo. I 
bring it into PS and I have the same thing: the 
background is transparent and I need for the 
transparent areas inside the outline of the 
flamingo to be white. Use the exact same 
method as step 3 > drag flamingo to working 
page. 

6. Go back to flamingo document > make a 
selection of some part of it > Edit > Define 
pattern 

7.Create new layer > using circle marquee to 
draw a selection in the image > Edit > Fill > 
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Pattern > the flamingo pattern I just made, 
checkmark “Scripted Patterns” and choose 
Symmetry Fill > OK > make a cool design out 
of the flamingo and it will fill the circle only, 
perfectly centered. If you want, choose 
blending options and add a stroke around it to 
help define it. If you want, you can make 
copies of this layer and start moving them 
around to fill the space with this shape/pattern, 
but that is not what I want to do. 

Demonstration: Shading & Shadow 

I love to work with dimensionality to add depth to 
my images. I accomplish this with shadow and 
shading. That will set my pages apart from most of 
what is on the market today. 

1. Select the layer with Alice > double click the 
Layer Style (which I created when I added the 
stroke to Alice) > I want to add a drop shadow. 
You don’t really see the impact it makes until 
you use the preview check box to turn it on and off. It makes her look like she stepped 
away from the background. 

2. Right mouse click on fX > copy layer style > choose 
flamingo layer > paste layer style > repeat on circle 
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3. A drop shadow isn’t going 
to work on the bottom 
leaf area. Double click on 
fX and add an Outer 
Glow to this layer. 
Change color to black 
and blend mode to 
multiply, adjust opacity, 
spread and size. We end 
up with great dimension 
in the coloring page. Most 
coloring mediums are 
translucent so this 
shadowing will show 
through and give 
dimension to the colored 
image. 
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4. Another thing we can do is add non-coloring elements, a no-no rule we are going to break. 
Change foreground color to a medium gray > select gradient tool > choose white 
background layer > fill from gray at the bottom to white at the top. This kind of defines 
where they should color (white areas) but they could add color to the gray background if 
they want. 
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5. Next, we will add some type. Type layer on top > choose font (impact here) > then change 
font color to white > right click > blending options > stroke and drop shadow. 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Demonstration: Make flamingo’s head look like it wraps around the 
other flamingo. 

1. Using a layer mask is easiest but because we are using a drop shadow, we cannot do that. 
The shadow will show.  

2. Make a copy of Alice layer > turn off drop shadow on this layer copy > bring to front (below 
right). 

3. Layer mask on this layer > 
command/ctrl click on layer with the 
zentangle flamingo to make a 
selection out of it. 

4. Paint brush > black color > paint on 
top layer mask in area right where 
the Alice flamingo is on top of the 
zentangle flamingo. End result 
makes it look like their necks are 
intertwined. 
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INSERTING HIDDEN OBJECTS 

Inserting hidden objects in a coloring page is a popular theme in coloring books and an area of 
interest to a lot of you. It is super simple to do.  

Demonstration: Hidden Objects 

1. Search pixabay for “flower.” This will be our hidden object. download and open in 
Photoshop. 

2. Lock layer > fill to black 
> click on outside area 
with magic wand > 
control/cmd shift I to 
invert > new layer > 
move layer to bottom > 
fill to white > merge 
layers > save. 

3. To add the flower to our 
illustration, select it > left 
mouse and hold > drag over to 
the open tab of our illustration 
and onto the page > let go > 
resize and position to fit where 
you want it.  

That is all you have to do. It takes 
a little planning before creating 
your designs to allow for the 
hidden objects, but hiding them in 
a drawing is just this simple; and 
you can hide multiple objects in a 
single drawing if you want. 

When putting hidden objects in our 
drawings, we have to include a 
Key at the front of the book to 
show what objects are hidden 
throughout the pages and how 
many times the object is hidden 
throughout the book. Use the 
original saved black & white flower 
for the key. 
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Session Q & A 

Q: Can I take photos of private property, convert them to illustrations and publish them without 
reprisal? For example, could I take photos of McDonalds and do an entire book about them or 
do they own the rights to their name and buildings? 
A: It depends. There are a lot of private buildings that you cannot photograph in any form. 
McDonalds is definitely hands off. Any commercial enterprise that has a recognizable building 
is off limits. You would have to license their trademarks. You couldn’t go to any Frank Lloyd 
Wright building, take photos of it and use those for a coloring book without permission. The 
same is true of any National Park. You cannot to use commercially any photos or video shot 
within the park without a permit. 

Q: Any alternatives to Corel Painter to do the Tessellation? 
A: Not that I am aware of. 

Q: Create base image with iOrnament and load into Pixelmator. When using kaleidoscope in 
Pixelmator, it seems to make the base image go off center. Advice? 
A: First thing that comes to mind is to create designs in a bigger canvas than you need them to 
be and crop later; or make a selection, like a circle, that is an active selection, before starting 
kaleidoscope and that may force it to stay centered. It works in Photoshop sometimes, and 
may work in Pixelmator. 

Q: If we don’t know any of this software, how can we best get started so we can get our books 
out there while still learning? 
A: This is an advanced class. If you haven’t watched the Coloring Book Master Class yet, you 
have to start by watching those videos. It is a complete training for basic designs from start to 
publishing. Then watch the bonus videos of my Photoshop training included with that class. 

Q: Number of sites like archive.org have terms and conditions. If public domain, why do they 
have terms and conditions? 
A: Most sites I’ve used do not have terms and conditions. If they do have and the images are 
public domain, ignore them. Public domain cannot be owned. That is nonsense that some try 
to add to their sites to make you think they control the images. Now, with archive.org, there is 
some content on that site that is not public domain and is still protected by copyright. That site 
is very good about telling you exactly what is and isn’t protected by copyright. 

Q: Can I take one of the old comic book images, add my own talk bubbles and it becomes my 
own copyrighted image? 
A: Yes. As long as it is in the public domain, you need no permission and your design is 
protected by copyright. That does not preclude anyone else from using the same comic book 
images with their own talk bubbles and copyrighting theirs as well 
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Q: From a return on investment perspective, how much time should we spend on each 
coloring book page? 
A: That can vary quite a bit based on what kind of page you want to create. If you are working 
with stock images and they need editing, that can take time. If you are compositing like we 
were doing here, that can take time. If you are making mandalas or using one of the apps we 
used in the other course, that could come together very quickly. It also depends on how many 
pages you include. My designs are taking 2-4 hours per image because they are more 
involved and I am experimenting a lot. If I wasn’t experimenting, I could probably bring that 
down to an hour to hour and a half per image. At the end of the day, if you want your book to 
look thrown together, that is exactly what you will get. If you slap something together and the 
negative reviews start to come in, you have a problem. Always remember, it is easy to build on 
a good reputation from the get-go; it is tough to recover from a bad one. 

Q: Any plugins in Illustrator to ease process of bringing photo or old image into vector 
graphics? 
A: None that I’ve discovered. I’ve shown a couple of different techniques for doing this. What 
you are asking for to take a photo and create a high-quality vector is the bane of my existence. 
It just isn’t easy. 

Q: Can you reverse Alice’s direction? 
A: Yes. Edit > Transform > Flip Horizontal 

Q: Do you really need the shadow detail on bottom leaf area if have the gradient background? 
A: Maybe not. Your drawing, your choices. It could add another layer of depth. 

Q: Would you now merge all layers and save as 300 dpi tiff? 
A: Yes. Layer > flatten image > file > save as. It could be tiff (the better choice, technically) or 
jpg 

Q: Confused. Thought you said we should not use stock images because we would have to 
pay for extended license but that is what you did. 
A: That isn’t exactly what I taught. Every site has its own license terms. I am downloading from 
Shutterstock because their terms allow that when the images are used for books, you can use 
the standard license as long as you don’t publish more than one-half million copies. As soon as 
you cross the half-million mark, you have to buy the extended license. The exception is where 
you use a single image as a primary driver, like in t-shirts. Then, you are required to have 
extended license. But in publication, that is not the case.  

Q: How do you add a pattern to an image. For instance, if the flamingo you added was not 
filled with a pattern but you wanted to add one, how? 
A: Demonstration: Filling an object 
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1. Starting with a silhouette of flamingo that I downloaded, open in Photoshop > lock layer > 
fill white > right mouse click > blending options > stroke on inside so we can see what we 
have to work with. 

2. We could generate a pattern using Filter Forge or use pattern fill built into Photoshop > 
keep layer locked so that whatever we do is constrained to the pixels, not the outside area 
that is transparent > Edit > Fill > Symmetry Fill > choose our flamingo pattern we made, a 
symmetry type, etc. just like we’ve done many times before and our flamingo is filled. 

3. You can get a little more creative. Maybe in the curve of the neck and head, you want to do 
a completely different pattern > using lasso tool of choice, create a selection of that > go to 
Fill again and select another 
pattern you’ve made and fill 
just that selected area. If you 
want to, you can segment 
the rest of the flamingo’s 
body parts and fill with 
different patterns. 
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Q: Do you print out your final pages to check to see if details are big enough to color? 
A: Absolutely. 

Q: When creating coloring book images, should we always be working with vectors even when 
compositing? 
A: You don’t have to. I think they are often easier to edit, you can scale them bigger without 
pixelizing, and the conversion process tends to smooth out the lines so I like them, but you 
don’t have to work with vectors at all. 

Q: Is there a free replacement for Illustrator? 
A: Inkscape is an open-source alternative. 

Q: When picture of Alice is finished, will the gray background show up? 
A: Yes. I’ve done gradient testing and they will. Keep in mind that in final print, regardless of 
the way you are printing these books, gradients increase in darkness anywhere from 5–10%. 
In other words, if you have a gradient or tone that is 10%, when printed it will be anywhere 
from 15% to 20% due to the printing process. The same is true for drop shadows. Use smartly 
because they will be darker in print than the way they appear on the screen. 

Q: Do men like different designs/objects to color than women? 
A: I would think so. I imagine the ratio of women to men who are coloring is pretty significant. 
There don’t seem to be a lot of artistic-thinking men who are comfortable in their own skin. I 
don’t think it has been fully communicated yet that men can enjoy coloring. That may change 
because Marvel is coming out with several coloring books based on The Avengers and others, 
but I would expect the designs to be different. 

Q: Which Wacom tablets are good for tracing and doing line drawing? 
A: Pressure sensitive and these days with blue tooth so you are untethered. They aren’t 
terribly expensive—$60 to $70 these days depending on size—though they can be. The 
Cintique tablet where you can draw on the screen starts at around $1,800. 

Q: What is purpose of flattening? 
A: For your final image to be printed, you cannot have layers. You need to collapse it down to 
a single layer. Flatten function takes all the layers you used to construct your image and 
condenses down to one layer. 

Q: Do you have to convert to cmyk before printing? 
A: In the case of coloring books, no. If you were doing color, you would need to, but these are 
black and white images so that conversion just happens automatically in the prep for print. 
There is also the option to convert to grayscale. You don’t want to do that because if you print 
a black and white image in rgb, you are going to get denser blacks than you would in 
grayscale. Stick to rgb. 
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Q: How did you subtract from a selection? 
A: Depends on the program you are in but in Photoshop, if you have a selection and hold 
down the option/alt key while selecting the area you don’t want to include, you will subtract that 
from your selection. Holding down the shift key instead of option/alt lets you add to your 
selection. 

Q: Is there any way to select just a section of a pattern like the flower or the little circles? 
A: You cannot just create a subset of a pattern to use for fill. You have to create a new pattern. 
You can take the pattern you want to use and easily change it or select part of it and then 
create a new pattern to use. 

Demonstration: Changing Part of a Pattern 

For something like changing the center circles in this pattern to something different, you can 
just magic wand those centers and fill with whatever. You could choose every connecting 
pattern or any part that is related and change that by filling with anything you want. For 
example, make your selection > create new document the same size > make a basic vertical 
line stripe > save as pattern > go back to the initial pattern and fill with the line pattern in the 
selection. Now you have a variation on the same theme to use. 

Say you want to add the stripe just to the flamingo’s bill. 
Magic wand the bill and add this pattern. You can add a 
lot of layers of complexity to your image just by using 
simple selections. You can just as easily fill black areas 
as white.  
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Q: Adobe has 40 million royalty-free images available with subscription to Photoshop/Illustrator 
for a total of $80 per month. Is this a good alternative to Shutterstock? You are limited to 
downloading 10 images per month. 
A: It may be. I haven’t read their terms of use so not quite sure what their rules are. 

Q: Can you define as a pattern a mandala you’ve already created? 
A: Sure. You can define anything you have as a pattern. 

1. Open it in Photoshop with a transparent background 

2. Command/ctrl left mouse click on the thumbnail of the image in the layers stack to create a 
selection around every pixel on the layer > click crop tool to put crop edges around the 
selection > hit return twice and it crops image to the selection. Image needs to be a square. 

3. Command/ctrl A to select all > Edit > define pattern. 

Now, you can open an image, Edit > fill and find this pattern in your fill selections where you 
can use it as you do any other fill. NOTE: the resolution of the mandala will control how big or 
small the pattern is and it is best that you not get too detailed or too complex an image for 
making the pattern or it will get messy when used to fill. 

Q: Can you move the fill around inside a filled object? 
A: Not dynamically. 

Q: What scanner do you use? 
A: Canon Canoscan LIDE220 and it requires no outside power. It is powered by USB on your 
computer. LIDE scanners do not generate heat, a requirement for taking a scanner to the 
National Archives. 

Q: Is it okay to photograph and use “public” buildings? 
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A: Yes, for the most part. There are some cities that have new license requirements for 
photographing public buildings. 

Q: Do men color at all? 
A: Some do. 

Q: Can you add pattern into an object with a clipping mask and is there any advantage/
disadvantage? 
A: I never use them. it is one of the ways that could be used to move patterns around in an 
image, but I just don’t use them at all. 

Q: Does Drag and Drop Illustrator have any tools for turning image into unfilled line drawing? 
A: No. 
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